# Table of Contents

**Introduction** 5

**Part 1: Planning Your Installation**

**Chapter 1: Installation and testing checklist for IBM Cognos Business Viewpoint** 7
- Review the release notes before you install 9
- Review supported environments 9
- Verify system requirements 10
- Checklist for reviewing the environments of other products 11
  - Interoperability of IBM Cognos Business Viewpoint with other products 11

**Chapter 2: Setting up your IBM Cognos Business Viewpoint Client environment** 9
- Setting up your IBM Cognos Business Viewpoint Client environment 9
  - Review the release notes before you install 9
  - Review supported environments 9
  - Verify system requirements 10
  - Checklist for reviewing the environments of other products 11
    - Interoperability of IBM Cognos Business Viewpoint with other products 11

**Part 2: Installation and Configuration of IBM Cognos Business Viewpoint Client**

**Chapter 3: Installing IBM Cognos Business Viewpoint Client** 13
- Set your JAVA_HOME variable 13
- Install IBM Cognos Business Viewpoint Client 14
- Install Planning Integration for Analyst and Contributor 16
  - Configure IBM Cognos Business Viewpoint Client to connect to IBM Cognos Business Viewpoint Server 17

**Chapter 4: Configuring IBM Cognos Business Viewpoint Client adapters** 19
- Configure the Analyst adapter 19
  - Create a macro to start IBM Cognos Business Viewpoint Client from Analyst 20
- Configure the Contributor adapter for versions prior to 8.4 23
- Configure the Contributor adapter for version 8.4 24
  - Add a custom menu command to start IBM Cognos Business Viewpoint Client from Contributor 25
- Configure the Controller adapter 27
- Configure the CSV adapter 28
- Configure the IBM Cognos TM1 adapter 29
- Configure the Transformer adapter 31
  - Configure Transformer to launch IBM Cognos Business Viewpoint Client 32
  - Configuring IBM Cognos Business Viewpoint Client and Transformer for the UNIX operating system 32
- Configure the Relational adapter 33
- Configure the IBM InfoSphere Master Data Management Server adapter 34

**Part 3: Appendixes**

**Appendix A: Setting up an unattended installation and configuration** 37
- Setting up an unattended installation 37
- Setting up an unattended configuration 39
- Setting up an unattended uninstallation 40
Appendix B: Troubleshooting 43
Log files 43
Java out-of-memory exceptions 44
Error verifying that security provider classes were loaded 45
Unable to read the contents of the keystore 45
Library numbers already in use message starting Analyst 46

Appendix C: Keyboard Shortcuts in the Installation Wizard 47

Index 49
Introduction

With IBM® Cognos® Business Viewpoint Client, you can nominate dimensions from IBM Cognos Planning - Analyst, IBM Cognos Planning - Contributor Administration Console, IBM Cognos TM1®, IBM Cognos Controller, IBM Cognos Transformer, relational data sources, IBM InfoSphere™ Master Data Management Server, and CSV files into IBM Cognos Business Viewpoint Studio. You can also update the dimensions that are in Business Viewpoint Studio with changes made in any of those components or data sources.

You can also subscribe to dimensions that are in Business Viewpoint Studio. For example, you nominate a Products dimension from one D-List of Analyst to Business Viewpoint Studio. You make changes to the Products dimension in Business Viewpoint Studio, and then subscribe to the Products dimension from a different Analyst D-List.

When you subscribe to a dimension from an IBM Cognos tool, like Analyst, a copy of the dimension from Business Viewpoint Studio is moved to Analyst. If the dimension is modified in either of these locations, the data will no longer be synchronized. To ensure that you have the same data in both places, you can run an update.

This document includes the information you need to install IBM Cognos Business Viewpoint Client.

Audience

This document is intended to help system administrators and information technology specialists install Business Viewpoint Client.

Finding information

To find IBM® Cognos® product documentation on the web, including all translated documentation, access one of the IBM Cognos Information Centers at http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp. Updates to Release Notes are published directly to Information Centers.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility Features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. The installation wizard has accessibility features. For information on these features, see "Keyboard Shortcuts in the Installation Wizard" (p. 47).

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.
Introduction
Chapter 1: Installation and testing checklist for IBM Cognos Business Viewpoint

The following checklist will help you ensure that you install and test the IBM® Cognos® Business Viewpoint features that you want to deploy.

☐ Prepare for implementation.
   This task is typically performed by a team assembled and led by the performance management solutions architect. Implementing Business Viewpoint means installing and configuring it to integrate effectively with your existing infrastructure.
   For information about preparing for implementation, see "Setting up your IBM Cognos Business Viewpoint Client environment" (p. 9).

☐ Install and configure Business Viewpoint Server.
   This task is usually performed by a system administrator or Information Technology consultant.
   For more information, see the IBM Cognos Business Viewpoint Server Installation and Configuration Guide.

☐ Create a data source in the IBM Cognos Business Intelligence environment (optional).
   By creating a data source in the IBM Cognos Business Intelligence environment, you can enable the publishing of packages from Business Viewpoint to Business Intelligence.
   For more information, see the IBM Cognos Business Viewpoint Server Installation and Configuration Guide.

☐ Test that a Business Viewpoint Studio user can publish packages to IBM Cognos Business Intelligence.
   For more information, see the Business Viewpoint Studio User Guide.

☐ Configure IBM Cognos Software Development Kit to run Business Viewpoint tasks (optional).
   You can configure the IBM Cognos Software Development Kit to enable BI Software Development Kit users to create scripts that run Business Viewpoint tasks automatically.
   For more information, see the IBM Cognos Business Viewpoint Server Installation and Configuration Guide.

☐ Test that the IBM Cognos Software Development Kit configuration was successful.
   For more information, see the IBM Cognos Software Development Kit Developer Guide.

☐ Set up and maintain security.
   Business Viewpoint uses authentication that is configured in an existing IBM Cognos Business Intelligence environment.
To set up security in Business Viewpoint, use Business Viewpoint Studio to change the initial user password, specify the IBM Cognos BI system, and manage users. For more information, see the Business Viewpoint Studio User Guide.

☐ Test that security was set up successfully.
To test that Business Viewpoint security was set up successfully, see the Business Viewpoint Studio User Guide.

☐ Install and configure Business Viewpoint Client.
Install and configure Business Viewpoint Client to enable other IBM Cognos applications to interoperate with Business Viewpoint Studio. For more information, see "Installing IBM Cognos Business Viewpoint Client" (p. 13).

☐ Test the configuration of Business Viewpoint Client.
Test the Business Viewpoint Client configuration to ensure that other IBM Cognos products can work with Business Viewpoint. For more information, see the Business Viewpoint Client User Guide.

☐ Install and configure Business Viewpoint for Microsoft® Excel.
For information about how install and configure Business Viewpoint for Microsoft Excel, see the IBM Cognos Business Viewpoint for Microsoft Excel Installation and Configuration Guide.

☐ Test the configuration of Business Viewpoint for Microsoft Excel.
To test the configuration of Business Viewpoint for Microsoft Excel, see the IBM Cognos Business Viewpoint for Microsoft Excel Installation and Configuration Guide.
Chapter 2: Setting up your IBM Cognos Business Viewpoint Client environment

Before you install IBM® Cognos® Business Viewpoint Client, you must review requirements and set up resources in your environment so that the components can operate.

Use the following checklist to guide you through the setup process:

- Review the release notes for late-breaking issues. For more information, see "Review the release notes before you install" (p. 9).
- Review an up-to-date list of environments supported by IBM Cognos products. For more information, see "Review supported environments" (p. 9).
- Check the minimum hardware and software requirements to install and run Business Viewpoint Server. For more information, see "Verify system requirements" (p. 10).
- Examine the environments of the other products that you want to work with Business Viewpoint. For more information, see "Checklist for reviewing the environments of other products" (p. 11).

After you complete these tasks, you can install and configure Business Viewpoint Client. For more information, see "Installing IBM Cognos Business Viewpoint Client" (p. 13).

Review the release notes before you install

Before you install IBM® Cognos® Business Viewpoint Client, it is important to be aware of all issues that may affect your installation strategy.

There may be late-breaking issues that were not known when this installation guide was created.

Review the release notes before you install your product. The release notes document contains late-breaking information about known issues as well as documentation updates and deprecation notices. It is available from the first page of the installation wizard or from the product CD.

Review supported environments

To ensure your product works properly, apply all minimum required operating system patches and use only the versions of other software that are supported for IBM® Cognos® Business Viewpoint.

To review an up-to-date list of environments supported by IBM Cognos products, including operating systems, patches, browsers, and database servers, visit the IBM Cognos Resource Center (http://www.ibm.com/software/data/cognos/customercenter/).

It is important to note that the Linux® operating system is available in a number of distributions and supports a number of hardware platforms. Ensure that the operating system and hardware combination you are using is a supported combination.
Verify system requirements

Use the following table to check the minimum hardware and software requirements to install and run IBM® Cognos® Business Viewpoint Client. Additional resources may be required for distributed or production environments.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft® Windows®</td>
</tr>
<tr>
<td></td>
<td>UNIX®</td>
</tr>
<tr>
<td></td>
<td>Linux®</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td>Operating system specifications</td>
<td>File descriptor limit set to 2048 on UNIX and Linux</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software and 4 GB of free space on the drive that contains the temporary directory used by IBM Cognos components. For all databases, the size will increase over time. Ensure that you have sufficient disk space for future requirements.</td>
</tr>
<tr>
<td>Java™ Runtime Environment (JRE)</td>
<td>An IBM JRE is installed automatically with IBM Cognos Business Viewpoint Server on Windows.</td>
</tr>
<tr>
<td>Database</td>
<td>IBM DB2® UDB 9.5 and 9.7</td>
</tr>
<tr>
<td></td>
<td>Oracle 11G</td>
</tr>
<tr>
<td></td>
<td>Microsoft SQL Server 2005</td>
</tr>
<tr>
<td></td>
<td>TCP/IP connectivity is required for all database types.</td>
</tr>
<tr>
<td>Web browser</td>
<td>For all Web browsers, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>● cookies</td>
</tr>
<tr>
<td></td>
<td>● JavaScript</td>
</tr>
<tr>
<td></td>
<td>For Microsoft Internet Explorer only, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>● Run ActiveX controls and plug-ins</td>
</tr>
<tr>
<td></td>
<td>● Script ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td></td>
<td>● Active scripting</td>
</tr>
</tbody>
</table>
Checklist for reviewing the environments of other products

IBM® Cognos® Business Viewpoint Client provides the means for other IBM Cognos products to integrate with Business Viewpoint Studio. Therefore, when you plan your installation of Business Viewpoint Client, you must first decide which IBM Cognos applications you require it to work with. For information about supported IBM Cognos applications and how they can be used with Business Viewpoint Studio, see "Interoperability of IBM Cognos Business Viewpoint with other products" (p. 11).

**Important:** You must install Viewpoint Client on the same computer as the IBM Cognos application that it will work with.

Use the following checklist to ensure that the environment where you want to install Business Viewpoint Client is suitable:

- Ensure that a supported version of the other product is installed on the computer where you plan to install Business Viewpoint Client. For more information, see "Product versions supported by IBM Cognos Business Viewpoint" (p. 11).
- Ensure that there are no firewall restrictions to prevent you from connecting to the computer where Business Viewpoint Server is installed.

Interoperability of IBM Cognos Business Viewpoint with other products

You can configure Business Viewpoint Client to operate with several other products. To help you decide which product adapters you need to configure, check the supported versions and the IBM Cognos features you can enable.

Product versions supported by IBM Cognos Business Viewpoint

The following product versions are supported by IBM® Cognos® Business Viewpoint:

- IBM Cognos 8 Planning - Analyst versions 7.3, 8.1, 8.2, 8.3, and 8.4
- IBM Cognos 8 Planning - Contributor versions 7.3, 8.3, and 8.4
- IBM Cognos Transformer version 8.4 and later
- IBM Cognos TM1® versions 9.1, 9.4, and 9.5
- IBM Cognos 8 Controller version 8.3
- IBM InfoSphere™ Master Data Management Server

IBM Cognos product features that you can enable through Business Viewpoint Client

The following table describes how IBM Cognos product features are extended when their adaptors are configured in Business Viewpoint Client.
<table>
<thead>
<tr>
<th>IBM Cognos Product</th>
<th>Extended Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos 8 Planning - Analyst</td>
<td>The nomination of Analyst D-Lists can be updated in Business Viewpoint Studio. Subscribing to a Business Viewpoint hierarchy or dimension can allow multiple D-Lists to be centrally managed within Business Viewpoint.</td>
</tr>
<tr>
<td>IBM Cognos 8 Planning - Contributor</td>
<td>The nomination and management of Contributor E-Lists and rights lists can be updated in Business Viewpoint Studio. This allows for the central management of multiple E-Lists and rights lists using external security, as well as access tables.</td>
</tr>
<tr>
<td>IBM Cognos Transformer</td>
<td>Dimensions can be nominated and managed in Business Viewpoint. Multiple Transformer models can subscribe to a single dimension in Business Viewpoint and be centrally managed.</td>
</tr>
<tr>
<td>IBM Cognos TM1</td>
<td>Bidirectional integration takes place between Business Viewpoint and IBM Cognos TM1 dimensions. Integration with the security model in IBM Cognos TM1 is also supported.</td>
</tr>
<tr>
<td>IBM Cognos 8 Controller</td>
<td>IBM Cognos 8 Controller data can be added to an existing dimension in Business Viewpoint Studio.</td>
</tr>
</tbody>
</table>
Chapter 3: Installing IBM Cognos Business Viewpoint Client

Install and configure IBM® Cognos® Business Viewpoint Client to enable business users to nominate master dimensions into IBM Cognos Business Viewpoint Studio from the following components or data sources:

- IBM Cognos Planning - Analyst
- IBM Cognos Planning - Contributor Administration Console
- IBM Cognos TM1®
- IBM Cognos Controller
- IBM Cognos Transformer
- relational data sources
- IBM InfoSphere™ Master Data Management Server
- comma-separated values (CSV) files

For information about the IBM Cognos products that you can integrate with IBM Cognos Business Viewpoint, see "Configuring IBM Cognos Business Viewpoint Client adapters" (p. 19).

You can install the Business Viewpoint Client on UNIX® or Linux® operating systems. On Microsoft® Windows®, Business Viewpoint Client provides both a graphical interface and a command line interface. On UNIX or Linux operating systems, the client provides only a command line interface.

Set your JAVA_HOME variable

Set JAVA_HOME if one of the following applies to you:

- You want to use your own JRE® and have a JAVA_HOME variable already set to that location on the Microsoft® Windows® operating system
- You are installing on the UNIX® or Linux® operating system.

Step

- Ensure that the JAVA_HOME environment variable is set to the JRE location.

  For example, to set JAVA_HOME to a JRE that you are already using, the path is `Java_location/bin/jre/version`.

  **Important:** The version must be 1.5.0 or higher.

  On the Windows operating system, you can set JAVA_HOME as a system variable or a user variable. If you set it as a system variable, it may be necessary to restart your computer for the
setting to take effect. If you set JAVA_HOME as a user variable, set it so that the environment in which Tomcat is running can access it.

Install IBM Cognos Business Viewpoint Client

Install IBM® Cognos® Business Viewpoint Client to enable business users to nominate master dimensions from IBM Cognos Planning - Analyst, IBM Cognos Planning - Contributor Administration Console, IBM Cognos TM1®, IBM Cognos Controller, IBM Cognos Transformer, relational data sources, IBM InfoSphere™ Master Data Management Server, and CSV files into IBM Cognos Business Viewpoint Studio.

Before you install IBM Cognos Business Viewpoint Client, you must do the following:

- Install IBM Cognos Business Viewpoint Server.
  For more information, see the IBM Cognos Business Viewpoint Server Installation and Configuration Guide.

- Set up your environment. This task involves reviewing supported environments, verifying system requirements, and examining the environments of the IBM Cognos products that you want to work with IBM Cognos Business Viewpoint.
  For more information, see "Setting up your IBM Cognos Business Viewpoint Client environment" (p. 9).

Steps for Microsoft Windows operating systems

1. Go to the computer that has an installed version of the IBM Cognos product that IBM Cognos Business Viewpoint Client will connect to.

   Important: If you install IBM Cognos Business Viewpoint Client on a different computer than the target application, IBM Cognos Business Viewpoint Client will not be able to connect to the application.

2. Insert the IBM Cognos Business Viewpoint Client disc or go to the location where the installation files were downloaded.

   The installation wizard starts automatically from the product disc.

3. On the Welcome page, click Next.

4. On the IBM License Agreement page, click I accept and then click Next.

5. On the Non IBM License Agreement page, click I accept and then click Next.

6. On the Installation Location page, accept or change the default location where IBM Cognos Business Viewpoint Client will be installed and click Next.

   Important:
   - If an IBM Cognos product was already installed in the default location, you must choose a different location.
• You must install IBM Cognos Business Viewpoint Client on the same computer as the application.

7. On the **Shortcut Folder** page, accept or change the default folder where shortcuts to IBM Cognos Business Viewpoint Client will be installed and click **Next**.

8. On the **Summary** page, click **Next**.

9. On the **Finish** page, do one or more of the following before clicking **Finish**:
   • View the transfer log file.
   • View the summary error log file.
   • Choose to view the Readme when you click **Finish**. Note that the Readme is now called Release Notes.
   • Choose to start IBM Cognos Configuration when you click **Finish**.

**Steps for UNIX and Linux operating systems**

1. On HP-UX, set the _M_ARENA_OPTS environment variable as follows:

```
_M_ARENA_OPTS 1:4
```
   This increases the memory allocation for HP-UX to more closely match that of other UNIX platforms.

2. If installing from a download, go to the location where the installation files were downloaded and extracted.

3. If installing from a disk, mount the disk using Rock Ridge file extensions.
   To mount the disk on HP-UX, do the following:
   • Add the pfs_mount directory in your path.
     For example,
     ```
     PATH=/usr/sbin/:$PATH
     export PATH
     ```
   • To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`
   • To mount the drive, type
     ```
     pfs_mount -t rrip <device><mount_dir> -o xlat=unix
     ```
     For example,
     ```
     pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     ```
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   • When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd and pfs_mountd daemons to unmount the disk.
Chapter 3: Installing IBM Cognos Business Viewpoint Client

4. To start the installation wizard, go to the operating system directory and then type 
   \setup

5. Follow the directions in the installation wizard to copy the required files to your computer. 
   Install the components in a directory that contains only ASCII characters in the path name. 
   Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.

6. On the Finish page, do one or more of the following before clicking Finish:
   - Note the location of the transfer log file.
   - Note the location of the summary error log file.
   - Choose to view the Release Notes.
   - Choose to start IBM Cognos Configuration.

7. Append the install_location/bin directory to the appropriate library path environment variable.
   - For Solaris and Linux, LD_LIBRARY_PATH
   - For AIX, LIBPATH
   - For HP-UX, SHLIB_PATH

Install Planning Integration for Analyst and Contributor

If you are using IBM® Cognos® Business Viewpoint with IBM Cognos Planning - Analyst or IBM 
Cognos Planning - Contributor Administration Console, you must also install Planning Integration 
components.

If you do not install Planning Integration, you can still manually create macros for Analyst and 
Contributor.

Steps
1. Insert the IBM Cognos Business Viewpoint Client disc or go to the location where the installation 
   files were downloaded.

2. Go to the IBM Cognos Business Viewpoint Client installation folder, open the 
   planningintegration\win32 folder, and double-click issetup.exe.

3. On the Welcome page, click Next.

4. On the IBM License Agreement page, click I accept and then click Next.

5. On the Installation Location page, accept or change the path to the location of the existing 
   Analyst or Contributor installation and click Next.
   Important: If you do not install Planning Integration with Analyst or Contributor, they will 
   not work with IBM Cognos Business Viewpoint Client.

6. On the Shortcut Folder page, accept or change the default folder where shortcuts to IBM 
   Cognos Business Viewpoint Client will be installed.
7. On the Summary page, click Next.

Configure IBM Cognos Business Viewpoint Client to connect to IBM Cognos Business Viewpoint Server

Connect IBM® Cognos® Business Viewpoint Client to an existing IBM Cognos Business Viewpoint Server environment to enable other IBM Cognos products to operate with IBM Cognos Business Viewpoint Studio.

Steps
1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Server.
3. Enter the Server host and Server port number for the computer where IBM Cognos Business Viewpoint Server is installed.
4. Click File > Save.
   If you are prompted with a message stating that IBM Cognos Configuration cannot obtain a CA certificate from Content Manager, click Yes to allow you to proceed.
5. Configure one or more adapters.
   For more information, see "Configuring IBM Cognos Business Viewpoint Client adapters" (p. 19).
Chapter 4: Configuring IBM Cognos Business Viewpoint Client adapters

You must configure IBM® Cognos® Business Viewpoint Client adapters to work with other IBM Cognos products, relational data sources, IBM InfoSphere™ Master Data Management Server, or comma-separated values (CSV) files. After you configure one or more adapters, you can transfer data between IBM Cognos Business Viewpoint Studio and the other applications.

Configure the Analyst adapter

To enable IBM® Cognos® Planning - Analyst to run in IBM Cognos Business Viewpoint Client, you must perform the following configuration tasks:

- Update two system environment paths to point to the appropriate bin directory.
- Configure the Analyst adapter to enable communication between the Analyst environment and the IBM Cognos Business Viewpoint environment.
- Create a macro that starts IBM Cognos Business Viewpoint Client. For more information, see "Create a macro to start IBM Cognos Business Viewpoint Client from Analyst" (p. 20).

Steps to update the system environment paths

1. Add an environment variable named BVC_HOME.
2. Set the value of BVC_HOME to the BusinessViewpointClient\bin directory.
   For example, C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin.
3. Add an environment variable named BVC_ANALYST_HOME.
4. Set the value of BVC_ANALYST_HOME to the IBM Cognos Planning Analyst\bin directory.
   For example, C:\Program Files\IBM\Cognos\planning\bin.

You may need to log off and on before the environment variables take effect.

Steps to configure the Analyst adapter

1. Go to IBM Cognos Configuration.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter Analyst for the name of the adapter. This will match the name referenced in the macro that is installed as part of the Planning Integration installation.

   Important: The name of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click Analyst and click OK.

6. To activate the adapter’s configuration, set Enabled to True.

7. In the Adapter ID box, enter a unique numeric value.

   **Important:** The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.

8. Click the version of Analyst that you are using.

9. If you are using Analyst version 7.3, do the following:
   - Enter the user name and password of the Analyst server.
   - Enter the name of the namespace that Analyst uses.

10. Save and close IBM Cognos Configuration.

11. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd.

   The utility will set up all the adapters that you configured. You can configure many different adapters and generate all the .cmd files at the same time.

Now you create a macro to start IBM Cognos Business Viewpoint Client when you click a custom toolbar button in Analyst. For more information, see "Create a macro to start IBM Cognos Business Viewpoint Client from Analyst" (p. 20).

### Create a macro to start IBM Cognos Business Viewpoint Client from Analyst

You need to create a macro that will start IBM® Cognos® Business Viewpoint Client when you click a custom toolbar button in Analyst. You can use one of the following methods:

- Use Planning Integration to create a macro named LaunchBVC and a new library named BusinessViewpointClient.

   You must install Planning Integration before you can create the macro. To install Planning Integration, see "Install Planning Integration for Analyst and Contributor" (p. 16).

- Create the macro manually if you want to select an existing library.

**Notes:**

- If you are also configuring the Contributor adapter, you must use the same process as you use for the Analyst adapter. For example, if you manually create the macro for Analyst, you must also manually create the menu command for Contributor.

- If you install Planning Integration to create the Analyst adapter, you do not have to install Planning Integration again to use with Contributor.

### Steps to use Planning Integration to create the macro

1. Ensure you have installed Planning Integration (p. 16).
2. If this is the first time that you have installed IBM Cognos Business Viewpoint Client, go to the Analyst_location\bin folder and double-click the LibrarySetupAnalystXX.bat file where XX is the version of Analyst that you have.

For example, if you are using Analyst version 8.4, double-click the LibrarySetupAnalyst84.bat file.

If you are using Analyst version 8.1, double-click the LibrarySetupAnalyst73.bat file.

The .bat file adds a registry entry that results in a library with ID 70040001 being created the next time you start Analyst.


4. Click Tools > Macros > Open Macro.

5. Double-click the LaunchBVC macro and do the following:
   - In the Pathname box, add the full path to the LaunchViewpointClient.bat file that is in the Analyst\bin directory.
     For example, C:\Program Files\IBM\Cognos\c10\bin\LaunchViewpointClient.bat
   - If you did not use the name Analyst for the adapter in IBM Cognos Configuration, change the name of the adapter to match the one that you used.
   - Save and close the macro.

6. Click the custom toolbar button called Start Business Viewpoint Client.

7. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd, where adapter_name is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.

   For example, if you named the adapter "Analyst" in IBM Cognos Configuration, double-click the file named ViewpointClient_Analyst.cmd.

Steps to create the macro manually

1. Start Analyst and do the following:
   - Click Tools > Options.
   - Click the Custom tab.
   - Click Browse beside the Custom Toolbar File box, and navigate to the location of the customtoolbar.txt file.
     The customtoolbar.txt file is located in the BusinessViewpointClient_location\IntegrationComponents\Analyst\misc directory.
     For example,
     C:\Program Files\IBM\Cognos\BusinessViewpointClient\IntegrationComponents\Analyst\misc\customtoolbar.txt
   - Click OK.
If prompted, restart Analyst.

2. Find the library ID number that you need for step 4 by doing the following in Analyst:
   - Click **File > Administration**.
   - Click the **Maintain Libraries and Users** tab.
   - In the **Libraries** tab, note the number for the library you are using.
   - Click Close.

3. To create a macro that runs a file, do the following:
   - Click **Tools > Macros > New Macro**.
   - Click **Insert**.
   - From the Group list on the left, select **Control**.
   - From the Function list on the right, select **Run**.
   - Click **Next**.
   - In the **Pathname** box, add the full path to the `ViewpointClient_<adaptername>.cmd` file that is in the `BusinessViewpointClient_location\bin\launchers` directory. Note that `<adaptername>` is the name of the Analyst adapter configured in IBM Cognos Configuration. For example, `C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin\launchers\ViewpointClient_Analyst.cmd`
   - From the **Options** box, select **Exit** to specify what the macro will do after running the .cmd file.
   - Click **Finish**.
   - Save the macro and name it **LaunchBVC**.

4. To complete the configuration of the custom toolbar button in Analyst that launches a macro to start IBM Cognos Business Viewpoint Client, do the following:
   - Go to `BusinessViewpointClient_location\IntegrationComponents\Analyst\misc` directory and open the file named `customtoolbar.txt`.
   - Ensure that the location of the `icon_consumerservice_16.bmp` file is in the same location as the `customtoolbar.txt` file and that the path is correct. For example, `C:\Program Files\IBM\Cognos\BusinessViewpointClient\IntegrationComponents\Analyst\misc\icon_consumerservice_16.bmp`.
   - Change the library ID to match the one you noted in Analyst.
     By default, the library ID in this file is 70040001.
   - Save and close the file.

For more information about custom toolbar text files, see the IBM Cognos Planning - Analyst User Guide.
5. Copy the following files to the Analyst_location:
   - Go to the BusinessViewpointClient_location\IntegrationComponents\Analyst directory.
   - Open the folder for the version of Analyst that you are using, such as Analyst 84.
   - Copy the .dll file and the .msg files to the Analyst_location\bin directory.
   - If you are using Analyst version 7.3 or 8.1, copy the files named XPJMDM02.UP1 and XPJMDM03.UP1 to the Analyst_location\bin\system directory. The files are located in the BusinessViewpointClient_location\IntegrationComponents\Analyst\misc directory.

6. Restart Analyst and click the custom toolbar button to start IBM Cognos Business Viewpoint Client.

   If IBM Cognos Business Viewpoint Client does not start, you may need to log off and then log on again. Or you may need to review the path in the macro you created to ensure that it is correct.

7. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd in the BusinessViewpointClient\bin\launchers folder where adapter_name is the name you gave the adapter.

   For example, if you named the adapter "Analyst" in IBM Cognos Configuration, double-click the file named ViewpointClient_Analyst.cmd.

Configure the Contributor adapter for versions prior to 8.4

You can perform configuration that allows users of Contributor versions prior to 8.4 to run IBM Cognos Business Viewpoint from the Contributor Administration Console (CAC).

Steps
1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   Important: The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click Contributor prior to version 8.4 and click OK.
6. To activate the adapter’s configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.
   Important: The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.
8. In the **User Import Location** box, enter the location from which E.Lists, AccessTables, and CAC rights can be imported. For example, type
   
   \texttt{d:/temp/userImportExportLocation/}

9. In the **User Export Location** box, enter the location to which E.Lists, AccessTables, and CAC rights can be exported. For example, type
   
   \texttt{d:/temp/userImportExportLocation/}

10. Save and close IBM Cognos Configuration.

11. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file generateFiles.cmd.
    The utility will set up all the adapters that you configured. You can configure many different adapters and generate all the .cmd files at the same time.

12. Test the configuration by double-clicking the file named ViewpointClient\_adapter_name.cmd, where \textit{adapter_name} is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.

    For example, if you named the adapter "ContributorAdapter" in IBM Cognos Configuration, double-click the file named ViewpointClient_ContributorAdapter.cmd.

---

### Configure the Contributor adapter for version 8.4

You can perform configuration that allows users of Contributor 8.4 to run IBM® Cognos® Business Viewpoint Client from the Contributor Administration Console (CAC).

To configure the Contributor adapter:

- Update the system environment path.
  
  If you have already updated the system path for Analyst, you do not need to perform this task.

- Configure the Contributor adapter.
  
- Use Planning Integration to be able to start IBM Cognos Business Viewpoint Client through a menu command in the Contributor Administrator Console. To install Planning Integration, see "Install Planning Integration for Analyst and Contributor" (p. 16).

---

### Steps to update the system environment path

1. Add an environment variable named \texttt{BVC_HOME}

2. Set the value of \texttt{BVC_HOME} to the BusinessViewpointClient\bin directory.

   For example, \texttt{C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin}.

   You may need to log off and on before the environment variables take effect.

### Steps to configure the Contributor adapter

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand **Environment** and click **Business Viewpoint Client Adapters**.

3. Right-click **Business Viewpoint Client Adapters**, and then click **New resource > Adapter**.

4. Enter a name for the adapter. Use **ContributorAdapter** to match the name referenced in the macro that is installed as part of the Planning Integration installation.

   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.

5. In the **Type** box, click **Contributor version 8.4** and click **OK**.

6. To activate the adapter’s configuration, ensure that **Enabled** is set to **True**.

7. In the **Adapter ID** box, enter a unique numeric value.

   **Important:** The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.

8. In the **IBM Cognos dispatcher URI** box, type `http://servername:9300/p2pd/servlet/dispatch`, where `servername` is the name of the IBM Cognos dispatcher computer.

9. Enter the IBM Cognos 8.4 namespace ID and the IBM Cognos user name and password.

10. Save and close IBM Cognos Configuration.

11. If you are finished configuring adapters, go to the `BusinessViewpointClient\bin\launchers` folder and double-click the file named `generateFiles.cmd`.

    The utility will set up all the adapters that you configured. You can configure many different adapters and generate all the .cmd files at the same time.

**Add a custom menu command to start IBM Cognos Business Viewpoint Client from Contributor**

You need to create a menu command that will start IBM® Cognos® Business Viewpoint Client when you click a menu button in Contributor.

**Notes:**

- If you installed Planning Integration to create the Analyst adapter, you do not have to install Planning Integration again to use with Contributor.

- If you are also configuring the Analyst adapter, you must use the same process as you use for the Contributor adapter. For example, if you manually create the menu command for Contributor, you must also manually create the adapter for Analyst.

**Steps to use Planning Integration to create the macro**

1. Ensure you have installed Planning Integration (p. 16).

2. Edit the file that is installed as follows:

   - Open the file `ViewpointClientConfig.xml` from the `Contributor_location\bin` folder.
Tip: This file adds a command to the Tools menu in the Contributor Administrator Console that starts IBM Cognos Business Viewpoint Client.

- If you want to use a different caption, replace the string "Business Viewpoint Client" with a new caption.
- If you did not use the name ContributorAdapter in IBM Cognos Configuration, replace [AdapterName] with the name you used for the adapter.

3. Start Contributor.


5. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd in the BusinessViewpointClient\bin\launchers folder where adapter_name is the name you gave the adapter.

For example, if you named the adapter "ContributorAdapter" in IBM Cognos Configuration, double-click the file named ViewpointClient_ContributorAdapter.cmd.

Steps to create the macro manually

1. Go to BusinessViewpointClient_location\IntegrationComponents\Contributor directory and open the file named ViewpointClientConfig.xml.

2. Find the following line:
   
   `<Resource ID="Command Line">cmd /c "[BV Client Install Location]\bin\launchers\ViewpointClient.cmd" [AdapterName]</Resource>`

3. Change the following values:

   - Change [BV Client Install Location] to the actual path of your install location. For example, change
     
     "[BV Client Install Location]\bin\launchers\viewpointclient.cmd"
     
     to something like
     
     "C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin\launchers\viewpointclient.cmd"
   
   - Change [AdapterName] to Contributor.

   For example, when you are finished the line should look something like
   
   `<Resource ID="Command Line">cmd /c "C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin\launchers\viewpointclient.cmd" Contributor</Resource>`

4. Save and close the file.

5. Copy ViewpointClientConfig.xml to the Contributor_location\bin folder.

6. Restart Contributor to access the macro.
Configure the Controller adapter

You can perform configuration that allows Controller users to run IBM® Cognos® Business Viewpoint.

Steps

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.

2. Expand Environment and click Business Viewpoint Client Adapters.

3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.

4. Enter a name for the adapter.
   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.

5. In the Type box, click Controller and click OK.

6. To activate the adapter's configuration, set Enabled to True.

7. In the Adapter ID box, enter a unique numeric value.
   **Important:** The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.

8. Enter the Controller user name.

9. In the Explorer window, right-click the adapter you just added, and then click New resource > Database.
   **Tip:** This is the database used by Controller.

10. Enter a name describing the Controller database, select the database type, and then click OK.

11. In the Resource Properties window, do the following:
   • Enter the computer name and port number of the database server.
   • Enter a user ID and password that has unrestricted access to the database server.
   • If you are connecting to a Microsoft® SQL Server database, enter the name it was given when it was created in Microsoft SQL Server.
   • If you are connecting to an Oracle database, enter the service name of the database instance.

12. Save and close IBM Cognos Configuration.

13. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd.
   The utility will set up all the adapters that you configured. You can configure many different adapters and generate all the .cmd files at the same time.

15. Click **Menu > Transfer > External Structures > Define Import Structure Specification**.

16. Define the structure.
   - Define Account Structure and default specification as #ST_ACCSTRUC
   - Click **Save As** and save this structure with the name BV_ACCSTRUC.
   - Repeat the steps above for Company Structure, Extended Dimensions 1-4, and Currency Conversion Rates using the following names:
     - **ACCOUNT_STRUCTUR - BV_ACCSTRUC**
     - **COMPANY_STRUCTUR - BV_COMPSTRUC**
     - **EXT_DIM1_STRUCTUR - BV_EXTDIM1**
     - **EXT_DIM2_STRUCTUR - BV_EXTDIM2**
     - **EXT_DIM3_STRUCTUR - BV_EXTDIM3**
     - **EXT_DIM4_STRUCTUR - BV_EXTDIM4**
     - **CURRENCY_CONV_RATES - BV_CURRRATES**

17. Test the configuration by double-clicking the file named ViewpointClient_**adapter_name**.cmd, where **adapter_name** is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.

   For example, if you named the adapter "Controller" in IBM Cognos Configuration, double-click the file named ViewpointClient_Controller.cmd.

**Configure the CSV adapter**

You configure the CSV adapter so that IBM® Cognos® Business Viewpoint Client users can work with CSV files.

To configure the CSV adapter, you must specify where the CSV files are read from and written to.

**Steps**

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand **Environment** and click **Business Viewpoint Client Adapters**.
3. Right-click **Business Viewpoint Client Adapters**, and then click **New resource > Adapter**.
4. Enter a name for the adapter.
   - **Important**: The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the **Type** box, click **CSV files** and click **OK**.
6. To activate the adapter’s configuration, set **Enabled** to **True**.
7. In the **Adapter ID** box, enter a unique numeric value.
Important: The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.

8. In the CSV file location box, enter the directory where you want to store temporary CSV files. For example, type

C:/temp/csvAdapterStore/

Tip: This directory must already exist on your system. IBM Cognos Business Viewpoint Client will not create it.

9. Save and close IBM Cognos Configuration.

10. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd.

    The utility will set up all the adapters that you configured. You can configure many different adapters and generate all the .cmd files at the same time.

11. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd, where adapter_name is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.

    For example, if you named the adapter "CSV" in IBM Cognos Configuration, double-click the file named ViewpointClient_CSV.cmd.

Configure the IBM Cognos TM1 adapter

You configure the IBM® Cognos® TM1® adapter so that IBM Cognos TM1 users can work with IBM Cognos Business Viewpoint Client.

Steps

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.

2. Expand Environment and click Business Viewpoint Client Adapters.

3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.

4. Enter a name for the adapter.

    Important: The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.

5. In the Type box, click TM1 and click OK.

6. To activate the adapter's configuration, set Enabled to True.

7. In the Adapter ID box, enter a unique numeric value.

    Important: The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.
8. From the **TM1 Version** box, select the version you are accessing.

9. Enter the name of the IBM Cognos TM1 server that was defined in IBM Cognos TM1 Architect.
   **Important:** This value is case sensitive.

10. Enter the computer name of the IBM Cognos TM1 Admin host.

11. Set security for IBM Cognos TM1:
   - To use native security in IBM Cognos TM1, enter the user name and password in the **TM1 user name and password** box.
   - To use IBM Cognos security in IBM Cognos TM1 version 9.4 or 9.5,
     Enter the dispatcher information, such as http://server_name/p2pd/servlet/dispatch/ext, in the **IBM Cognos dispatcher URI** box.
   **Important:** IBM Cognos TM1 and IBM Cognos Business Viewpoint must use the same IBM Cognos instance for security.

12. Enter the name of the namespace in the **IBM Cognos namespace ID** box.

13. Enter the user name and password in the **IBM Cognos username and password** box. All users will then use the same user name and password.

14. Leave the following boxes blank:
   - **IBM Cognos dispatcher URI**
   - **IBM Cognos namespace ID**
   - **IBM Cognos username and password**

15. In the **TM1 shared network path** box, enter the location of a shared network directory to which both the IBM Cognos TM1 server and the IBM Cognos Business Viewpoint client have read and write access.

16. Save and close IBM Cognos Configuration.

17. If you are finished configuring adapters, go to the **BusinessViewpointClient_location\bin\launchers** location and double-click the file named **generateFiles.cmd**.
   The utility will set up all the adapters that you configured by connecting to the IBM Cognos TM1 server for each IBM Cognos TM1 adapter, copying scripts to the IBM Cognos TM1 server data directory, and creating the link in IBM Cognos Business Viewpoint Client to the adapter.

18. In the folder **BusinessViewpointClient\bin\launchers**, double-click the file named **setupTM1Adapters.cmd**.
   IBM Cognos TM1 files and scripts are copied to the required directories.

19. Restart the IBM Cognos TM1 Server service.

20. Test the configuration by double-clicking the file named **ViewpointClient_adapter_name.cmd**, where adapter_name is the name you gave the adapter. The file is located in the **BusinessViewpointClient\bin\launchers** folder.
For example, if you named the adapter "TM1" in IBM Cognos Configuration, double-click the file named ViewpointClient_TM1.cmd.

**Configure the Transformer adapter**

You can perform configuration that allows IBM® Cognos® Business Intelligence Transformer users to work with IBM Cognos Business Viewpoint.

To enable IBM Cognos Business Viewpoint Client to run in Transformer, you must perform these tasks:

- Configure the Transformer adapter using IBM Cognos Configuration.
- Optionally, install the IBM Cognos 8 v4 Business Intelligence Server Component FixPack.

**Important:** The IBM Cognos 8 v4 Business Intelligence Server Component FixPack is not a standalone installation. It must be installed on computers that have IBM Cognos 8 Transformer 8.4 installed.

If you have IBM Cognos 8 Transformer 8.4.1 installed, you do not have to install the FixPack. To check your version, open the file named cmplst.txt, and check the line that starts with COGTR_version=. The file is located in the `install_location\cognos\c8` directory.

Before you install the IBM Cognos 8 v4 BI Server Component FixPack, back up any customized files from the current installation.

**Steps to configure the Transformer adapter**

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click Transformer and click OK.
6. To activate the adapter's configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.
   **Important:** The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.
8. Save and close IBM Cognos Configuration.
9. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file generateFiles.cmd.
Chapter 4: Configuring IBM Cognos Business Viewpoint Client adapters

The utility will set up all the adapters that you configured. You can configure many different adapters and generate all the cmd files at the same time.

10. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd in the BusinessViewpointClient\bin\launchers folder where adapter_name is the name you gave the adapter.

For example, if you named the adapter "Transformer" in IBM Cognos Configuration, double-click the file named ViewpointClient_Transformer.cmd.

Configure Transformer to launch IBM Cognos Business Viewpoint Client

You must configure IBM® Cognos® Transformer to enable integration with IBM Cognos Business Viewpoint Client.

**Important:** Ensure that you have configured the IBM Cognos Business Viewpoint Transformer adapter before you configure Transformer to launch IBM Cognos Business Viewpoint Client. For more information, see the IBM Cognos Business Viewpoint Client Installation And Configuration Guide.

**Steps**

1. Start Transformer.
2. Click **File > Preferences** and locate the **Business Viewpoint** tab.
   
   **Note:** If you do not see the **Business Viewpoint** tab, ensure that you have the correct version of Transformer installed.
3. Click **Enable Business Viewpoint Integration**.
4. Click **Browse** and locate the ViewpointClientCLL.cmd file found in the IBM Cognos Business Viewpoint Client <install_location>\bin\launchers directory.
5. Type the Transformer adapter name. This is the Transformer adapter name that was added in the IBM Cognos Configuration for IBM Cognos Business Viewpoint Client. If the Transformer adapter was not added, you should do so now. For more information, see the IBM Cognos Business Viewpoint Client Installation And Configuration Guide.
6. Click the **General** tab and ensure that the **Save Object Unique Identifier values in MDL** check box is selected.

Configuring IBM Cognos Business Viewpoint Client and Transformer for the UNIX operating system

You can use IBM® Cognos® Business Viewpoint Client and IBM Cognos Transformer in the UNIX® operating system. After you install IBM Cognos Business Viewpoint Client and Transformer in the UNIX operating system, you need to perform additional steps to enable the integration.

When configuring IBM Cognos Business Viewpoint Client using IBM Cognos Configuration, ensure that the adapter ID is the same as the one used for Windows to define subscriptions for the model. A subscription includes the path to the Transformer model file. Store the model under the Models
directory as defined in the Transformer preferences so the subscription contains a path relative to the Models directory that is valid on both the Microsoft® Windows® operating system and the UNIX operating system.

**Defining preferences**

Define the following preferences related to IBM Cognos Business Viewpoint Client integration in the Transformer preferences section located in the configuration `cogtr.xml` file.

- `<Preference Name="VSAdapter" Value="adapter-name" />`
- `<Preference Name="VSEnable" Value="1" />`
- `<Preference Name="VSPATH" Value="install-path/bin/launcher/ViewpointClientCLI.sh" />`
- `<Preference Name="ModelSaveDirectory" Value="model-save-path" />

The Transformer adapter in IBM Cognos Business Viewpoint Client also needs the `ModelSaveDirectory` defined in the configuration file named `cogtr.xml`. Alternatively, you can create a symbolic link to the Transformer `cogtr.xml` file.

**Configure the Relational adapter**

You can configure IBM® Cognos® Business Viewpoint Client to work with relational data sources directly.

**Steps**

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   
   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.

5. In the Type box, click Relational Database and click OK.
6. To activate the adapter’s configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.
   
   **Important:** The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.
8. Save and close IBM Cognos Configuration.

   The adapter is created in `BusinessViewpointClient\bin\launchers` folder.
You can also double-click the file named ViewpointClient\_adapter\_name\_.cmd, where \_adapter\_name\_ is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.

For example, if you named the adapter "RelationalAdapter" in IBM Cognos Configuration, double-click the file named ViewpointClient\_RelationalAdapter\_.cmd.

### Configure the IBM InfoSphere Master Data Management Server adapter

You can configure IBM® Cognos® Business Viewpoint Client to work with IBM InfoSphere™ Master Data Management Server.

#### Steps

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.

2. Expand Environment and click Business Viewpoint Client Adapters.

3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.

4. Enter a name for the adapter.

   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.

5. In the Type box, click IBM InfoSphere Master Data Management Server and click OK.

6. To activate the adapter’s configuration, set Enabled to True.

7. In the Adapter ID box, enter a unique numeric value.

   **Important:** The IDs of all adapter configuration instances must be unique among all adapter instances that are connected to the same IBM Cognos Business Viewpoint server. This includes adapter instances on other computers that are connected to the same server.

8. In the IBM InfoSphere Master Data Management Server Database connection string box, enter the location where the data is stored when it is loaded into IBM Cognos Business Viewpoint Studio.

   The string must be in the following format:

   USERID=<userid>,PASSWORD=<password>,SCHEMA=<schema>, CONNECTION_STRING=jdbc:db2j:net://<server>:<port>/<dbname>,DRIVER=driver

   For example,

   USERID=mdmuser, PASSWORD=user4mdm, SCHEMA=MDM_BVC_VIEWS, CONNECTION_STRING=jdbc:db2j:net://10.10.10.10:50000/mdm, DRIVER=com.ibm.db2.jcc.DB2Driver

9. In the IBM InfoSphere Master Data Management Server Staging Database connection string box, enter the location where data is written when updating data from IBM Cognos Business Viewpoint Studio to IBM InfoSphere Master Data Management Server.

   This connection string information uses the same syntax as above.
10. Save and close IBM Cognos Configuration.

11. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd.

   The utility will set up all the adapters that you configured. You can configure many different adapters and generate all the .cmd files at the same time.

12. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd, where adapter_name is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.

   For example, if you named the adapter "MDMServerAdapter" in IBM Cognos Configuration, double-click the file named ViewpointClient_MDMServerAdapter.cmd.
Appendix A: Setting up an unattended installation and configuration

Set up an unattended installation and configuration to perform the following tasks:

- Install an identical configuration across several computers on your network.
- Automate the installation and configuration process by specifying options and settings for users.
- Install and configure components in a UNIX® or Linux® operating system that does not have XWindows.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all other software that you need is installed and configured.

To set up an unattended installation and configuration, perform the following tasks:

- Configure a transfer specification file (.ats) to specify installation options.
- Run the installation tool in silent mode.
- Use a configuration file from another computer.
- Run the configuration tool in silent mode.

After you complete these tasks, ensure that the IBM® Cognos® Business Viewpoint installation directory on all computers is protected from unauthorized or inappropriate access. Then you will be ready to use Business Viewpoint.

Setting up an unattended installation

Use a transfer specification file (.ats) to copy IBM® Cognos® Business Viewpoint components to your computer without being prompted for information.

By default, each time you install Business Viewpoint using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed Business Viewpoint on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

If you do not use the installation wizard to install components, you can use the default transfer specification file named response.ats that is available on the CD. You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Steps using a file generated by an installation on another computer

1. Use the installation wizard to install Business Viewpoint on one computer.
Appendix A: Setting up an unattended installation and configuration

2. Go to Business_Viewpoint_installation_location\instlog.

3. Locate the transfer specification file (.ats) that was generated.
   The filename format is ts-BV-version-yyyyymmdd_hhmm.ats

4. Copy the transfer specification file to the computer where you plan to install Business Viewpoint.

5. On the computer where you plan to install the software, insert the appropriate CD and copy the contents of the CD to your computer.

6. In a text editor, open the transfer specification file that you copied.

7. In the section named License Agreement, change the ACCEPTED= property to y.

8. Save the transfer specification file in the directory where you copied the contents of the installation CD.

9. Install Business Viewpoint:
   - On a Microsoft® Windows® operating system, open a Command Prompt window, and change to the win32 directory where you copied the contents of the CD, and then type the following command, where location is the directory where you copied filename, the transfer specification file:
     `issetup -s location/filename.ats`
   - On a UNIX® or Linux® operating system, change to the directory where you copied the contents of the CD, and in the directory for your operating system, type the following command, where location is where you copied filename, the transfer specification file:
     `./issetup -s location/filename.ats`

If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the Business_Viewpoint_installation_location\instlog directory in a summary error log file. The filename format is tl-BV-version-yyyyymmdd-hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is tl-BV-version-yyyyymmdd-hhmm.txt.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

**Steps using the response.ats file**

1. On the target computer, insert the CD and copy the contents to your computer.

2. Go to the operating system directory and open the response.ats file in a text editor.
   Each section in the response.ats file corresponds to a dialog box in the installation wizard.

3. In the section named License Agreement, change the ACCEPTED= property to y.

4. Type the installation location of the program files for IBM Cognos Business Viewpoint Client in APPDIR=location.
   **Tip:** There should be no space on either side of the equal sign, (=).
5. For IBM Cognos Business Viewpoint Client, in the section named [Component List], next to each component:
   - To install the component, type 1
   - To not install the component, type 0
   All required files are installed.

6. For a Windows installation, for the APPFOLDER= property, type the name of the Start menu folder that contains your program shortcuts.
   
   Tip: To ensure that the shortcut folder is visible to all users, type 1 for the ALLUSERS_FLAG= property.

7. For the install information in the [Install Conditions] section:
   - To specify the condition is true, type 1
   - To specify the condition is false, type 0

8. Save the response.ats file to a local directory after you make the necessary changes.

9. Go to the operating system directory.

10. At the command prompt type the following command, where location is the directory where you copied response.ats:
    - On the Windows operating system, type 
      \issetup -s location/response.ats
    - On the UNIX or Linux operating system, type 
      ./issetup -s location/response.ats

    If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the c10_location\uninstlog directory in a summary error log file. The filename format is tl-BV-version-yyyyymmdd-hhmm_summary-error.txt.

    If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is tl-BV-version-yyyyymmdd-hhmm.txt.

    Also ensure that the installation directory is protected from unauthorized or inappropriate access.

    After all errors are resolved, you can set up an unattended configuration.

---

**Setting up an unattended configuration**

Before you set up an unattended configuration, you must export a configuration from another computer that has IBM® Cognos® Business Viewpoint Client installed. You can then run IBM Cognos Configuration in silent mode.

The exported configuration contains the properties of Business Viewpoint Client that you installed on the source computer.
Appendix A: Setting up an unattended installation and configuration

Ensure that the configuration settings on the local computer are appropriate to use to configure another Business Viewpoint Client computer with the same installed components.

**Steps**

1. In IBM Cognos Configuration, click **File > Export as**.

2. If you want to export the current configuration to a different folder, in the **Look in** box, locate and open the folder.
   Ensure that the folder is protected from unauthorized or inappropriate access.

3. In the **File name** box, type a name for the configuration file.

4. Click **Save**.

5. Copy the exported configuration file from the source computer or network location to the `Business_Viewpoint_installation_location/configuration` directory on the computer where you plan to do an unattended configuration.

6. Rename the file to `cogstartup.xml`.

7. If you changed the global configuration on the source computer, copy the `coglocale.xml` file from the source computer to the `Business_Viewpoint_installation_location/configuration` directory on the computer where you plan to do an unattended configuration.

8. Go to `Business_Viewpoint_installation_location/bin`.

9. Type the configuration command:
   - On a Microsoft® Windows® operating system, type `cogconfig.bat -s`
   - On a UNIX® or Linux® operating system, type `/cogconfig.sh -s`

   **Tip:** To view log messages that were generated during an unattended configuration, see the `cogconfig_response.csv` file in the `Business_Viewpoint_installation_location/logs` directory.

   You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

   IBM Cognos Configuration applies the configuration settings specified in the local copy of `cogstartup.xml`, encrypts credentials, generates digital certificates, and starts the Tomcat server.

### Setting up an unattended uninstallation

Set up an unattended installation and configuration to perform the following tasks:

- Automate the removal of components on several computers that have the same components.
• Remove components in a UNIX® or Linux® operating system that does not have XWindows.

Steps
1. Go to Business_Viewpoint_installation_location/instlog.
2. In a text editor, open the transfer specification .ats file for the product:
   The filename format of the transfer specification .ats file is ts-BV-version-yyyyymmdd_hhmm.ats
   If you have more than one .ats file, you only need to edit one of the .ats files.
3. In the section named [Component List], specify the components to remove.
   • To remove the component, type 1.
   • To leave the component installed, type 0.
4. Save and close the file.
5. Go to the operating system directory.
6. At the command prompt, type the following command, where filename is the name of the transfer specification .ats file that you edited:
   • On a Microsoft® Windows® operating system, type
     \uninst -u -s Business_Viewpoint_installation_location/instlog/filename.ats
   • On a UNIX or Linux operating system, type
     ./uninst -u -s Business_Viewpoint_installation_location/instlog/filename.ats
Appendix A: Setting up an unattended installation and configuration
Appendix B: Troubleshooting

Use this troubleshooting information as a resource to help you solve specific problems you may encounter during or after the installation of IBM® Cognos® Business Viewpoint Client.

Problems are characterized by their symptoms. Each symptom can be traced to one or more causes by using specific troubleshooting tools and techniques. After being identified, each problem can be fixed by implementing a series of actions.

When you are troubleshooting, log files can help you. Another valuable troubleshooting tool is the Knowledge Base, which is available on the IBM Cognos Resource Center (http://www.ibm.com/software/data/support/cognos_crc.html). The Knowledge Base is a database of problems and solutions for all IBM Cognos products.

When you cannot resolve a problem, the final resource is your technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Log files

Log files can help you troubleshoot problems by recording the activities that take place when you work with a product. Operations performed in IBM® Cognos® Business Viewpoint Client are recorded in various log files for tracking purposes. For example, if you experienced problems installing IBM Cognos Business Viewpoint Client, consult the transfer log file to learn what activities the installation wizard performed while transferring files.

When troubleshooting, the following files can assist you.

Transfer log file

This file records the activities that the installation wizard performed while transferring files. The transfer log file is located in the Business_Viewpoint_Client_installation_location\instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

tl-MDMCS-8.1-0.0-20080901_1122.txt

Transfer summary-error log file

This file records the components you installed, disk space information, the selections you made in the transfer dialogs, and any errors the installation wizard encountered while transferring components. The transfer summary-error log file is located in the Business_Viewpoint_Client_installation_location/instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

tl-MDMCS-8.1-0.0-20080901_1122_summary_error.txt
**Startup configuration file**
This file records your configuration choices each time you save your property settings. The file name is cogstartup.xml. If you are unable to save your configuration, or are having problems you can revert to a previously saved configuration file. The backup configuration files are located in the Business_Viewpoint_Client_installation_location/configuration directory. The following is an example of the file name format for backup configuration files:

cogstartup_200811231540.xml

**Startup configuration lock file**
This file is created each time you open IBM Cognos Configuration. It prevents you from opening more than one IBM Cognos Configuration window. If you experience problems opening IBM Cognos Configuration, you can check the Business_Viewpoint_Client_installation_location/configuration directory for the cogstartup.lock file. If the file exists and IBM Cognos Configuration is not open, it means that IBM Cognos Configuration did not shut down properly the last time you used it. You can delete the lock file and then open IBM Cognos Configuration.

**Locale configuration file**
This file records the configuration choices you make in IBM Cognos Configuration for product and content locales, locale mapping, and currency support. If you experience problems with language support in the user interface or in reports, use these files to track your changes. The backup configuration files are located in the Business_Viewpoint_Client_installation_location/configuration directory. The following is an example of the file name format:

coglocale_200811231540.xml

**Uninstallation log file**
This file records the activities that the Uninstall wizard performed while uninstalling files. The log file is named cognos_uninst_log.htm and is located in the Temp directory. You can use the log file to troubleshoot problems related to uninstalling IBM Cognos Business Viewpoint Client.

**Silent mode log file**
This file records the activities that IBM Cognos Configuration performed while running in silent mode. This log file is named cogconfig_response.csv and is located in the Business_Viewpoint_Client_installation_location/logs directory.

**Java out-of-memory exceptions**
When using IBM® Cognos® Business Viewpoint Client, you may see Java™ out-of-memory exceptions.

To solve this problem, increase the amount of memory that Business Viewpoint Client allocates for Java from 1 GB to either 2 GB or 3 GB.

**Steps**
1. Go to the directory BusinessViewpointClient\bin.
2. For each of the files ViewpointClient.cmd, ViewpointClientCLI.cmd, and ViewpointClientCLI.sh, follow these steps:

- Open the file in a text editor.
- Find the following line:
  ```
  for machines with 1 GB RAM
  ```
- Go to the next line (that contains the characters VM_OPTS), and comment out the line.
- Uncomment either the VM_OPTS line that applies to 2GB or the VM_OPTS line that applies to 3GB.
- Save the file.

## Error verifying that security provider classes were loaded

When you start IBM® Cognos® Business Viewpoint Client, the following message is displayed:

`com.cognos.cclcfgapi.CCLConfigurationException: CAM-CRP-1085 An error occurred while verifying that the security provider classes were loaded. Reason: java.lang.ClassNotFoundException: org.bouncycastle134.jce.provider.BouncyCastleProvider`

This message displays because the JAVA_HOME environment variable is pointing to your copy of Java™ Runtime Environment (JRE) or JDK. However, the .jar (Java Archive) file, named bcprov-jdknn-nnn.jar, was not copied to your JRE.

To fix the problem, copy the bcprov-jdknn-nnn.jar file from the Business Viewpoint_installation_location/bin/jre/version/lib/ext directory to the Java_location/jre/lib/ext directory.

## Unable to read the contents of the keystore

When you start IBM® Cognos® Business Viewpoint Client, the following message is displayed:

`com.cognos.cclcfgapi.CCLConfigurationException: CAM-CRP-1064 Unable to process the PKCS #7 data because of an internal error. Unable to read the contents of the keystore 'C:/Program Files/IBM/Cognos/BusinessViewpoint/configuration/csk/CSKKeystore'. Reason: java.io.IOException: com.sun.crypto.provider.SealedObjectForKeyProtector`

These error messages display because the following events took place:

- Business Viewpoint Client was configured while the JAVA_HOME environment variable was pointing to the Sun version of Java™ Runtime Environment (JRE) or JDK. As a result, the product configuration was encrypted by the Sun JRE.
- JAVA_HOME was removed from your environment.
- Because JAVA_HOME was no longer set, Business Viewpoint Client used the IBM version of JRE that was bundled with Business Viewpoint Client.
- The IBM JRE could not decrypt the product configuration that was originally encrypted by the Sun JRE.
To fix the problem, choose one of the following options:

- Restore JAVA_HOME back to its original value, pointing to the Sun version of JRE or JDK.
- Verify that JAVA_HOME is not set. Then reinstall Business Viewpoint Client and use the IBM JRE.

**Library numbers already in use message starting Analyst**

When you start Analyst, the following message is shown:

*Installation of the following directories failed during startup, because some of the library numbers are already in use: 70040001*

This can occur if you have installed a previous version of the Planning Integration Kit or you have run AnalystRegistryUtility.exe. Both the Planning Integration Kit and the AnalystRegistryUtility.exe create a registry key. If this registry key is present, Analyst will show an error when you start it.

To resolve this problem, you must delete the registry key.

Open the Microsoft® Windows® Registry Editor, and locate the registry key named DEFLIB 70040001. The key is located under

```
HKEY_CURRENT_USER\SOFTWARE\Cognos\Planning##\Analyst\Startup
```

Delete DEFLIB 70040001, and follow the steps to use Planning Integration again.
Appendix C: Keyboard Shortcuts in the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

You can use the keyboard instead of the mouse for some actions.

Keyboard shortcuts are usually accessed by using the Alt, Ctrl, or Shift keys in combination with other keys. For example, Alt+S indicates that you press and hold the Alt key and then press the S key.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows® operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX® or Linux® operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
</tbody>
</table>
Appendix C: Keyboard Shortcuts in the Installation Wizard

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>
Index

A
Analyst adapters
configuring, 19
audience of document, 5

C
cogstartup.lock file, 44
configuration
lock file, 44
unable to open IBM Cognos Configuration, 44
unattended, 39
workflows, 7
configuration files
exporting, 39
configuring
Analyst adapters, 19
Business Viewpoint Client, 17
Business Viewpoint Client adapters, 19
Contributor adapters, 23, 24
Controller adapters, 27
CSV adapters, 28
InfoSphere Master Data Management Server adapters, 34
relational adapters, 33
TM1 adapters, 29
Transformer adapters, 31
unattended, 39
configuring Transformer for Business Viewpoint
Client, 32
Contributor adapters
configuring, 23, 24
Controller adapters
configuring, 27
CSV adapters
configuring, 28

D
description of product, 5

E
environment
setting up, 9
environments
supported, 9
exporting
configuration files, 39

I
IBM Cognos 8 Business Viewpoint
system requirements, 10
IBM Cognos Configuration
problems opening, 44
unattended mode, 39
InfoSphere Master Data Management Server adapters
configuring, 34
installation
workflows, 7
installing
Business Viewpoint Client, 14
IBM Cognos 8, 37
Planning Integration, 16
unattended install, 37
using transfer specification file (.ats), 37
using transfer specification files (.ats), 37

J
java out-of-memory errors, 44

K
keyboard shortcuts, 47
keystore error message, 45

L
log files, 43
locale configuration, 44
silent mode, 44
startup configuration, 44
transfer, 43
transfer summary, 43
uninstallation, 44

M
macro
creating, 20, 25

O
out-of-memory exception, 44

P
Planning Integration, 20, 24, 25
  installing, 16
  preparing to install, 9
  problems opening IBM Cognos Configuration, 44
  purpose of document, 5

R
relational adapters
  configuring, 33
  response.ats file, 37

S
  security
    settings for Web browsers, 10
  security provider classes error message, 45
  shortcut keys, 47
  silent uninstallation, 40
  startup
    configuration lock file, 44
  supported environments, 9
  system requirements, 10

T
TM1 adapters
  configuring, 29
Transformer
  using in the UNIX operating system, 32
Transformer adapters
  configuring, 31
  troubleshooting, 43

U
unable to open IBM Cognos Configuration, 44
unattended installation, 37, 40
uninstalling
  unattended, 40